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1 JDeveloper System Requirements

This release of Oracle JDeveloper is tested and supported on the specific versions
Windows, Linux, and Mac OS X, as listed in Section 1.1, "Recommended CPU,
Memory, Display, and Hard Drive Configurations". In addition, it is supported on any
operating system that supports the following versions of the JavaSE Development Kit
(JDK):

= JDK 6 Update 21 or later
= JDK7 Update 10 or later

For the most current information on software that is certified for use with Oracle
JDeveloper, see the Certification Information link for this release on the Oracle
Technology Network (OTN) web site:

ORACLE




http://www.oracle.com/technetwork/developer-tools/jdev/documenta
tion/index.html

1.1 Recommended CPU, Memory, Display, and Hard Drive Configurations

The following tables list the recommended CPU, memory, display, and hard drive
requirements for the different operating systems:

s Table 1, " Recommended CPU, Memory, Display, and Hard Drive Requirements
for Windows"

» Table 2, " Recommended CPU, Memory, Display, and Hard Drive Requirements
for Linux"

» Table 3, " Recommended CPU, Memory, Display, and Hard Drive Requirements
for MAC OS X"

The following table lists the recommended CPU, memory, display, and hard drive

requirements for the Windows operating system:

Table 1 Recommended CPU, Memory, Display, and Hard Drive Requirements for
Windows

Resource Recommended
Operating System Windows 7
Windows XP - Service Pack 3
CPU Type and Speed Pentium IV 2 GHz or faster
Memory 32-bit systems: 2 GB RAM
64-bit systems: 3 GB RAM
Display 65536 colors, set to at least 1024 X 768 resolution
Hard Drive Space Studio Edition: 3 GB
Java Edition: 90 MB
JDK n JDK 6 Update 21 for Windows or the most recent

update available at the time of install

n JDK 7 Update 10 for Windows or the most recent
update available at the time of install

Available to download at: http://www.ora-
cle.com/technetwork/java/javase/down-
loads/index.html

The following table lists the recommended CPU, memory, display, and hard drive
requirements for the Linux operating system:

Table2 Recommended CPU, Memory, Display, and Hard Drive Requirements for Linux

Resource Recommended

Distribution Red Hat Enterprise Linux 6.0
Red Hat Enterprise Linux 5.0
Oracle Enterprise Linux 6.0
Oracle Enterprise Linux 5.0
SUSE Linux Enterprise Server 11

CPU Type and Speed Pentium IV 2 GHz or faster

Memory 32-bit systems: 2 GB RAM
64-bit systems: 3 GB RAM

Display 65536 colors, set to at least 1024 X 768 resolution




Table 2 (Cont.) Recommended CPU, Memory, Display, and Hard Drive Requirements for

Resource Recommended
Hard Drive Space Studio Edition: 3 GB
Java Edition: 90 MB
JDK »  JDK 6 Update 21 for Linux or the most recent update

available at the time of install

= JDK 7 Update 10 for Linux or the most recent update
available at the time of install

Available to download at: http://www.ora-
cle.com/technetwork/java/javase/down-
loads/index.html

The following table lists the recommended CPU, memory, display, and hard drive
requirements for the Mac OS X operating system:

Table 3 Recommended CPU, Memory, Display, and Hard Drive Requirements for MAC
oS X

Resource Recommended

Operating System Apple Mac OS X Version 10.6 or later
CPU Type and Speed 64-bit Intel processors

Memory 3 GBRAM

Display "Thousands" of colors

Hard Drive Space Studio Edition: 3 GB

Java Edition: 90 MB

JDK The releases of Java for Mac OS X that corresponds to the
following JDK releases:

s JDK 6.0 Update 21 for Mac or the most recent update
available at the time of install

s JDK 7.0 Update 10 for Mac or the most recent update
available at the time of install

For example, Java for Mac OS X 10.6 Update 14 is available

at: http://support.apple.com/kb/DL1573.

2 JDeveloper Certification Information

For the most current information on software that is certified for use with JDeveloper,
see the Oracle JDeveloper documentation page on the Oracle Technology Network
(OTN) web site:
http://www.oracle.com/technetwork/developer-tools/jdev/documenta
tion/index.html.

Note: This version of Oracle JDeveloper ships with Apache ANT
1.7.1. Later versions of ANT may work with this release, but they are
not supported and may cause unexpected behavior.

3 Installing the Oracle JDeveloper Studio Edition

Oracle Installer can be used to install Oracle JDeveloper Studio 11.1.2.4.0, the ADF
Runtime, and Oracle WebLogic Server 11g Release 1 (10.3.5) on your system.

Oracle Installer is available in the following forms:




Two platform-specific installers that include JDK 6.0 Update 24. You need not have
the JDK pre-installed on your system to use these platform installers:

s  Windows Installer (jdevstudiolll24install.exe)
s Linux Installer (jdevstudiolll24install.bin)

Generic installer (jdevstudiolll24install. jar) that can be used to install
Oracle JDeveloper Studio on any platform. In order to use this installer, you must
have JDK 6.0 Update 21 or later installed on your system.

Note: Oracle recommends using the platform-specific installer
because it does not require the JDK to be preinstalled and is smaller
than the generic installer.

You can download Oracle Installer from the Oracle Technology Network (OTN) web
site:
http://www.oracle.com/technetwork/developer-tools/jdev/downloads
/index.html

For more information about installing the ADF Runtime, see the "Deploying Fusion
Web Applications" chapter in the Oracle Fusion Middleware Fusion Developer’s Guide for
Oracle Application Development Framework.

For more information about using the Oracle WebLogic Server in JDeveloper, see
Section 12, "Using Oracle WebLogic Server with JDeveloper".

Notes:

= If you are reinstalling the same version of JDeveloper after
uninstalling it, the system directory from the previous installation,
gets associated with the new installation by default. Therefore, if
you wish to reinstall the same version of Oracle JDeveloper, you
must either delete the previously created system directory first, or
set a new user home directory after reinstallation, as described in
Section 10, "Setting the User Home Directory".

= On Windows systems, if you are uninstalling your current version
of JDeveloper to install a newer version, Oracle recommends that
you reboot your system after uninstallation, and before you begin
the new installation.

3.1 Before You Begin

Before you run the generic installer, ensure that the following prerequisites are
satisfied:

You must have JDK 6.0 Update 21 or later installed on your system. If you don't
have JDK 6.0 Update 21 installed or the most recent update available at the time of
install, you can obtain it from:
http://www.oracle.com/technetwork/java/javase/downloads/index
.html.

To streamline your installation process, the JDK you wish to use with the product
should be the one you use to start the installer program. In that case, be sure the




desired JDK is the first one in your system PATH, or reference it explicitly on the
command line.

s If the JDK you use to launch the installer doesn't meet the minimum product
requirements, you will be given the opportunity to browse for one during the
installation process.

Note: JDK 6 Update 24 is installed automatically when you use the
platform-specific installer.

3.2 Launching the Installer

Depending on the type of installer you are using, you can begin the installation
process in one of the following ways:

s Tolaunch the platform-independent installer, enter: java -jar
jdevstudiolll24install.jar.

s To launch the Windows installer, double-click the
jdevstudiolll24install.exe file.

»  Tolaunch the Linux installer, follow these steps:

1. Ensure that the jdevstudiolll24install.bin file is executable: chmod
+x jdevstudiolll24install.bin.

2. Execute the file: . /jdevstudiolll24install.bin.

You can also launch the installer in silent mode, to ensure that no configuration
options are displayed during the installation process. For more information, see
Section 13.1, "Installing Oracle JDeveloper Studio in Silent Mode".

3.3 Installer Screens

The installer provides several screens that allow you to specify various parameters for
the installation:

1. Welcome
Click Next to begin the installation process.
2. Choose Middleware Home Directory

You can create a new Middleware Home directory, or select one from a list of
existing Middleware Home directories. If you choose a directory that already has
Oracle JDeveloper and Oracle WebLogic Server components installed on it, you
are taken directly to the Choose Products and Components screen to select
additional components to install.

If you choose to create a new Middleware Home directory, the default provided is
C:\Oracle\Middleware\ for Windows, and $HOME/Oracle/Middleware/
for Linux and Unix platforms.

Caution: Ensure that you choose a directory that does not contain
spaces. For example, do not use C: \Program Files as the
Middleware Home.




Notes:

s The JDeveloper component should always be installed in new
Middleware Home. The only component in the Oracle installer
that can be installed into an existing Middleware Home is the
Application Development Framework, and that should not be
done if ADF has already been installed on the system by other
Oracle Fusion Middleware products.

s For the remainder of this document, in the context of the Studio
Edition, Mw_HOME has been used to represent the Middleware
Home directory that you have chosen. For example, if you
selected C: \Oracle\ as your Middleware Home directory, then
Mw_HOME would refer to C: \Oracle\.

Choose Install Type

Select either Complete or Custom depending on the type of installation you want
to perform. Selecting Complete will install Oracle JDeveloper Studio, Application
Development Framework Runtime, and Oracle WebLogic Server on your system.
For more information about the Oracle WebLogic Server components that are
installed in the complete installation, see the Oracle Fusion Middleware Installation
Guide for Oracle WebLogic Server.

Selecting Custom takes you to the Choose Products and Components screen,
where you can select the components you want to install.

Choose Products and Components (Custom Install only)

Select the components you wish to install. If you deselect a component that is
needed by other components, those are deselected as well. For more information
about Oracle WebLogic Server components, see Oracle Fusion Middleware Getting
Started With Installation for Oracle WebLogic Server.

Notes:

= If you choose to not install the Application Development
Framework Runtime component, you can still run ADF
applications by installing Oracle Application Developer, which
provides the ability to configure standalone ADF applications on
Oracle WebLogic Server in an environment managed by Oracle
Enterprise Manager. For more information, see Section 12.2,
"Configuring Oracle WebLogic Server for ADF".

= If some components are already installed in your Middleware
Home directory, they will appear grayed out on this screen.

JDK Selection (Generic Installer only)

If you did not launch the generic installer with the JDK you wish to use for the
product, or the one you launched it with does not meet the minimum
requirements, you may select the location of your desired JDK now. Navigate to
your JDK directory that contains the child folder bin, which in turn contains
java.exe. For example, if the path for your java.exe is C: \JDK\jdk1.6.0_
21\bin\java.exe, you should select C: \JDK\jdk1l.6.0_21.




10.

11.

Confirm Product Installation Directories

View the directories that the components will be installed in. To make changes,
click Back and navigate to the desired screen, or click Next to continue with the
installation.

Note: In addition to the disk space required by the components you
have chosen to install, the installer needs 684MB of temporary work
space. If there is insufficient disk space on your system, a dialog will
appear informing you about it. You can then either free up space in
your desired location, or click Previous and choose an alternate
location on the Choose Middleware Home Directory screen.

Install Windows Service (Windows systems only)

Select to install the Node Manager Service. Node Manager is used to monitor,
start, and stop server instances in a domain. For more information, see the Oracle
Fusion Middleware Installation Guide for Oracle WebLogic Server.

Note: ]JDeveloper and ADF do not require the use of the Node
Manager Service.

Choose Shortcut Location (Windows systems only)

Select the Start Menu folder where you want to place your shortcuts. You can
select one of the following options:

s "All Users" Start Menu folder

Select this option to provide all users registered on this machine with access to
installed software. Only users with Administrator privileges can create
shortcuts in the All Users folder.

s Local user's Start Menu folder

Select this option to ensure that other users registered on this machine will not
have access to the Start menu entries for this installation.

Installation Summary

Displays the components that will be installed and total disk space that will be
utilized.

Installation status
Displays the progress of the installation.
Installation Complete

Select Run Quickstart to open the Quickstart window once the installation process
has ended. Quickstart enables you to easily launch installed components and
access online documentation.

Click Done to end the installation process.




Note: Should the installation process be interrupted prior to
completion, the result is likely an incomplete and non-functional
partial installation. If this occurs, the recommended approach is to
attempt to uninstall the previous installation. If that is successful, you
can re-install normally, otherwise you should re-install into a new
middleware home.

3.4 Verifying Your Installation

To view information about which products and components were installed, open the
registry.xml file, located at: Mw_HOME/registry.xml.

4 Installing the JDeveloper Java Edition

The JDeveloper Java Edition does not require an installer. To install JDeveloper Java,
you will need an unzip tool. You can download a free, cross-platform unzip tool,
Info-Zip, available at: http: //www. info-zip.org/.

Caution: Ensure that you install JDeveloper into a directory that
does not contain spaces. For example, do not use C: \Program
Files as the installation directory.

To install JDeveloper from jdevjavalll24.zip:

1. If you don't have JDK 6.0 Update 21 installed or the most recent update available
at the time of install, you can obtain it from:
http://www.oracle.com/technetwork/java/javase/downloads/index
.html.

2, Unzip jdevjavalll24.zip to the target directory.

Note: For the remainder of this document, in the context of the Java
Edition, 1w_HONME is used to represent the directory of the installation.
For example, if you unzipped jdevjavalll24.zipinto C:\jdev_
install\, then MW_HOME refers to C:\jdev_install.

5 Using JDeveloper on Windows

Once the installation is complete, you can begin using JDeveloper on Windows
systems.

5.1 Starting JDeveloper

To start Oracle JDeveloper Studio on Windows, use any of the following methods:

= From your Start Menu, select All Programs, then select Oracle Fusion
Middleware 11.1.2.4.0, and then select JDeveloper Studio 11.1.2.4.0.

= You can also start JDeveloper from the command line by running one of the
following commands:

s MW_HOME\jdeveloper\jdeveloper.exe




s MW _HOME\jdeveloper\jdev\bin\jdevw.exe

s MW _HOME\jdeveloper\jdev\bin\jdev.exe (to display a console
window for internal diagnostic information)

5.2 Specifying the JDK location

If you installed JDeveloper using the generic installer, you will need to specify the
location of your JDK installation in the dialog that appears when you start JDeveloper
for the first time. You will need to enter the path to the Java executable, for example
D:\jdkl.6.0_21\bin.

5.3 Changing the JDK location

To change a JDK location that you have previously specified, set the variable
SetJavaHome in the file Mw_HOME\jdeveloper\jdev\bin\jdev.conf to the
location of your JDK installation. Use an editor that recognizes UNIX end-of-line
characters, such as WordPad. When you save the file, WordPad will warn you that it is
about to save the file in text-only format. You can ignore this warning.

For example, in a Windows environment, if the location of your JDK is in a directory
called jdk1.6.0_21 on your D: drive, your entry in jdev. conf would look like:

SetJavaHome d:\jdkl.6.0_21

5.4 User Directories

The following list describes the default directory structure within JDeveloper on
Windows:

»  The default location for the system subdirectory is
$APPDATA%\JDeveloper\systemll.1l.2.4.XX.XX.XX, where XX .XX.XX is
the unique number of the product build.

»  The default location for user-generated content is:

- C:\Users\user\Documents\JDeveloper\mywork on Windows 7
systems.

- C:\JDeveloper\mywork on all other Windows platforms.

For more information on user directories and how to set the value for the home
environment variable, see Section 10, "Setting the User Home Directory".

6 Using JDeveloper on Linux and UNIX Systems

Once the installation is complete, you can begin working with JDeveloper on Linux
and UNIX systems.

6.1 Changing System Cursors

On UNIX or Linux platforms, the Java cursors may display large and opaque, creating
difficulties when used for drag and drop operations. To address this problem
JDeveloper provides a set of cursors to replace the default set. You must have write
access to the JDK in order to replace the cursors.

To replace the cursors:




1. Make a backup copy of the default cursors located in the JDK directory at:
<jdk_install>/jre/lib/images/cursors
2. Extract the replacement cursors from the tar file at:

MW_HOME/jdeveloper/jdev/bin/clear_cursors.tar

6.2 Setting the System Resource Limit

The minimum recommended system resource limit for Oracle JDeveloper on Linux
systems is 4096.

To determine the resource limit configuration for your system, enter:

» /bin/sh -c¢ 'ulimit -n’

If the value returned is less than 4096, you set the system resource limit:

1. Openthe 1imits.conf file, which is located in the /etc/security/ directory.
2. Look for the following lines:

* soft nofile <value>
* hard nofile <value>
3. In the lines, change the value to 4096. The lines will then read:

* soft nofile 4096
* hard nofile 4096

Note: In case the lines listed in Step 2 do not exist, add the lines
listed in Step 3 to the 1imits. conf file.

6.3 Starting JDeveloper

To start JDeveloper on Linux and UNIX, run the file 1m_
HOME/jdeveloper/jdev/bin/jdev.

6.4 Specifying the JDK location

If you installed JDeveloper using the generic installer, when you start JDeveloper for
the first time, the jdev script prompts you to provide the location of your JDK
installation if it cannot locate it. You will need to enter the path to the Java executable,
for example /usr/local/java/bin/java.

6.5 Changing the JDK location

To change a JDK location that you have previously specified, set the variable
SetJavaHome in the file MW_HOME/jdeveloper/jdev/bin/jdev.conf to the
location of your Java installation.

For example, in a UNIX environment, if the location of your JDK is in a directory
called /usr/local/java, your entry in jdev.conf would look like:

SetJavaHome /usr/local/java

10



7 Using JDeveloper on Mac OS X Platforms

Once the installation is complete, you can begin using JDeveloper on Mac OS X
platforms.

7.1 Starting JDeveloper

To start JDeveloper, run the file Mw_HOME/jdeveloper/jdev/bin/jdev.

7.2 Specifying the JDK location

If you installed JDeveloper using the generic installer, when you start JDeveloper for
the first time, the jdev script prompts you to provide the location of your JDK
installation if it cannot locate it. You will need to enter the path to the Java executable,
for example /usr/local/java/bin/java.

7.3 Changing the JDK location

To change a JDK location that you have previously specified, set the variable
SetJavaHome in the file MW _HOME/jdeveloper/jdev/bin/jdev.conf to the
location of your Java installation.

For example, in a Mac OS X environment, if the location of your JDK is in a directory
called /usr/local/java, your entry in jdev.conf would look like:

SetJavaHome /usr/local/java

8 Migrating from a Previous Version

This version of JDeveloper supports migration from JDeveloper 11.1.1.1.0 or later only.
Oracle recommends migrating to JDeveloper 11.1.1.1.0 from all other earlier versions
before migrating to this release of Oracle JDeveloper.

8.1 Migrating User Settings

When you start JDeveloper for the first time (and each time after adding a new
extension or making an upgrade), JDeveloper will display the Confirm Import
Preferences dialog to ask whether to import your preferences and settings from a
previous installation.

On the Confirm Import Preferences dialog, click Show All Installations to view a list
of all previous installations. From this list, choose the installation that you want to
import preferences and settings from. Hovering over a particular installation displays
the path to the installation as a tooltip. Alternatively, you can click the Find a previous
installation manually button (with the image of a magnifying glass) on the top right
of the installation list to browse for an installation manually. Clicking Yes on the
Confirm Import Preferences dialog imports user preferences and the state of the IDE
from the previous installation.

To force JDeveloper to display the Confirm Import Preferences dialog, use the
-migrate flag when starting Oracle JDeveloper from the command line, for example,
jdev -migrate.

Note: If you migrate to another version of Oracle JDeveloper, you
will need to reinstall the extensions that you want to use.

1



8.2 Migrating Projects

When you open an application or project that was created in a prior release,
JDeveloper will prompt to migrate the project to JDeveloper 11g. Depending on the
content of the projects, JDeveloper may display additional prompts to migrate some
specific source files as well. Oracle recommends that you make a backup copy of your
projects before migrating. See the Oracle JDeveloper page on OTN for more
information about migrating specific types of projects to 11g.

8.2.1 Migrating JSF and JSTL Projects

This version of JDeveloper requires that all projects with JavaServer Faces and JSTL be
migrated to the latest versions of these technologies (2.0 and 1.2 respectively).
Additionally, any web . xml deployment descriptors will be migrated to version 2.5.

For the most current information on migration, see the Oracle JDeveloper
documentation page on OTN:
http://www.oracle.com/technetwork/developer-tools/jdev/documenta
tion/index.html.

9 Enabling JDeveloper Extensions

Before you can use an extension in JDeveloper, you first need to download the
extension from OTN. An example of an available JDeveloper Extension is JUnit.

To automatically download and install an JDeveloper extension:
»  From the Help menu, select Check for Updates.

On the Source page of the Check for Updates wizard, you can specify the update
center to download the extension from, or specify a local file to install the
extension from.

You can search the following update centers:
- Oracle Fusion Middleware Products
- Official Oracle Extensions and Updates
- Open Source and Partners Extensions
- Internal Automatic Updates

To manually download an JDeveloper extension:

1. Goto
http://www.oracle.com/ocom/groups/public/@otn/documents/webco
ntent/131167.xml.

2. Select an JDeveloper Extension.

3. Follow the instructions to download the zip file.

To manually install an JDeveloper Extension:

1. Verify if there are additional installation instructions in the extension archive.
2. From the Help menu, select Check for Updates.

3. OnStep 1 of the wizard, select Install from a Local File and navigate to the ZIP
file.

4. Finish the wizard and restart JDeveloper. After you restart JDeveloper, you will be
able to use the extension.
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10 Setting the User Home Directory

This section provides instructions on how to define a user home environment variable
and set its value for each user in order for JDeveloper to identify user home directories
correctly.

The user home directory contains the user's preferences for JDeveloper (in the system
subdirectory). It is also the default location for new projects (in the
\JDeveloper\mywork\ directory) as well as other configuration files that are
specific to a given user.

Caution: Ensure that you choose a Home directory that does not
contain spaces. For example, do not use C: \My Home as your home
directory.

To define the name of the user home environment variable:

1. Open the file Mw_HOME/jdeveloper/jdev/bin/jdev.boot in a text editor.
Use an editor that recognizes UNIX end-of-line characters, such as WordPad.

2. Find the entry:
ide.user.dir.var = JDEV_USER_HOME, JDEV_USER_DIR

This is the default variable that JDeveloper will look for at startup. You can define
or add any environment variable that JDeveloper should use. As the terminal
server administrator, you may change the name of this variable to follow your
system's naming conventions.

Note: You can explicitly set the home environment variable by
adding the following line in the jdev.boot file: ide.user.dir =
<Path to preferred user directory>

The output should look something like this:

ide.user.dir D:/users/jdoe (on Windows)
ide.user.dir = /home/users/jdoe (on Linux and UNIX)

3. Save the file. If you are using WordPad, it will warn you that it is about to save the
file in text-only format. You can ignore this warning.

The user home directory can also be specified from the command line using this
command:

jdev.exe -J-Dide.user.dir=<Path>
Examples:
» Jjdev.exe -J-Dide.user.dir=D:/users/jdoe (on Windows).

» Jjdev.exe -J-Dide.user.dir=/home/users/jdoe (on Linux and UNIX).

10.1 Setting the Home Environment Variable on Windows

To set the home environment variable on a Windows systems, including individual
users of JDeveloper on a multiuser system, use the following steps:
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Caution: Do not set the home environment variable to a directory
that contains spaces. For example, do not specify C: \My Projects
as the home directory.

1. From the Windows Start menu, select Control Panel, and then select System.
Select the Advanced tab, then click Environment Variables.

In the User Variables section, click New.

P »® N

Add JDEV_USER_DIR, or the name you chose for ide.user.dir.var, as a user
variable.

5. Set the value of this variable to your home directory (for example,
N:\users\jdoe), and click OK.

6. To check your variable setting, open a command shell and enter:
set
You should see output similar to the following;:
JDEV_USER_DIR=N:\users\jdoe

7. Launch JDeveloper.

8. From the Help menu, select About to verify that the value of ide.user.diris
set to your user home directory.

10.2 Setting the Home Environment Variable on Linux and UNIX

Use the following steps to set the environment variable on Linux and UNIX systems.
The examples and syntax provided refer to the C Shell.

Caution: Do not set the home environment variable to a directory
that contains spaces. For example, do not specify home/jdoe/my
projects as the home directory.

1. In your startup configuration file (for example, . cshrc), set the environment
variable to your preferred directory:

setenv JDEV_USER_DIR S$HOME/mydocs/jdevfiles
2. Source the file to make your changes take effect:
source .cshrc
3. Display the environment variable to confirm the change:
echo $JDEV_USER_DTR
You should see output similar to the following:
/home/jdoe/mydocs/jdeviiles
4. Launch JDeveloper.

5. From the Help menu, select About to verify that the value of ide.user.diris
set to your user home directory.

By default, the user home directory on Linux and UNIX is $HOME/ jdevhome.
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10.3 Setting the Home Environment Variable on Mac OS X

Use the following steps to set the environment variable on Mac OS X systems. The
examples and syntax provided refer to the BASH shell.

Caution: Do not set the home environment variable to a directory
that contains spaces. For example, do not specify home/jdoe/my
projects as the home directory.

1. In your startup configuration file (for example, .bashrc), set the environment
variable to your preferred directory:

JDEV_USER_DIR=$SHOME/mydocs/jdevfiles

2. Export the new value of the environment variable:
export JDEV_USER_DIR

3. Source the file to make your changes take effect:

.profile

4. Display the environment variable to confirm the change:
echo $JDEV_USER_DIR
You should see output similar to the following;:
/Users/jdoe/mydocs/jdeviiles

5. Launch JDeveloper.

6. From the Help menu, select About to verify that the value of ide.user.diris
set to your user home directory.

By default, the user home directory on Mac OS X is $SHOME/jdeveloper.

11 Using JDeveloper in a Multiuser Environment

You can install JDeveloper in Microsoft Terminal Server, Citrix MetaFrame and
MetaFrame XP (for Windows), and MetaFrame 1.1 for UNIX environments. These
environments allow many clients to access one installation of JDeveloper. In all cases,
users can save their projects locally.

When installing and configuring JDeveloper for a multiuser environment, you'll need
to account for resource planning, such as number of users and power of the server to
deliver optimal performance for JDeveloper and your users.

11.1 Installing JDeveloper on a Citrix MetaFrame Server or a Microsoft
Terminal Server

You need to have administrative privileges to install JDeveloper.
To install JDeveloper on a Citrix MetaFrame or Microsoft Terminal Server:
1. Install JDeveloper.

2. Define the user home directory environment variable as instructed in Section 11.2,
"Configuring User Home Directories in a Multiuser Environment" and in
Section 11.3, "Configuring Terminal Server Clients for Running JDeveloper".
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11.2 Configuring User Home Directories in a Multiuser Environment

Before you run JDeveloper in a terminal server environment, you may want to define
the user home environment variable and set its value for each user, in order for
JDeveloper to identify user home directories correctly. If the variable is not defined
and set, JDeveloper uses the Mw_HOME\JDeveloper\system\ directory for each
user for storing system settings, and C: \JDeveloper\mywork as the default user
source directory for all users. See Section 10, "Setting the User Home Directory" for
instructions on how to configure user home directory environment variables.

11.3 Configuring Terminal Server Clients for Running JDeveloper

This section assumes that you have already installed a Citrix MetaFrame or Microsoft
Terminal Server client locally and that JDeveloper has been installed and configured
by the system administrator.

To configure a terminal server client for running JDeveloper:

1. Verify that the color resolution of the terminal server client has been set to a
minimum of 256 colors. This minimum resolution is required by Java JDK 6.0.

2. Log on to your terminal server.

3. Verify that the user home environment variable has been defined: Ask your
system administrator for the naming convention that is used on your system. The
default variable is JDEV_USER_DIR.

4. Set the user home environment variable, as described in Section 10.1, "Setting the
Home Environment Variable on Windows".

5. Launch JDeveloper.

6. JDeveloper will ask if you would like your user home directory to be created.
Click Yes.

7. From the Help menu, select About to verify that the value of ide.user.diris
set to your user home directory.

If you run JDeveloper in a multiuser environment and you see the error

The system DLL ole32.dll was relocated in memory. The
application will not run properly. The relocation occurred
because the DLL Dynamically Allocated Memory occupied an address
range reserved for Windows NT system DLL's. The vendor supplying
the DLL should be contacted for a new DLL.

You will need to update the Mw_HOME\ jdeveloper\jdev\bin\jdev.conf file by
uncommenting the line:

AddvMOption -Xheapbasel00000000

Use an editor that recognizes UNIX end-of-line characters, such as WordPad. You may
have to change the number upward or downward if you still get the error when
starting JDeveloper. When you save the file, WordPad will warn you that it is about to
save the file in text-only format. You can ignore this warning.

In addition, each user must modify the default project to apply this setting. To specify
this value in the default project settings:

1. From the Application menu, select Default Project Properties.

2. In the Default Project Properties dialog, click Run/Debug/Profile, and then click
Edit.
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3. Click the Launch Settings node.

4. On the Launch Settings page, enter ~Xheapbasel00000000 in the Java Options
field.

12 Using Oracle WebLogic Server with JDeveloper

Note: This section is not applicable to the Java edition.

Installing Oracle JDeveloper Studio 11g Release 2 (11.1.2.4.0) also automatically installs
Oracle WebLogic Server 11g Release 1 (10.3.5). JDeveloper uses this preconfigured
installation as the Integrated Oracle WebLogic Server, an JDeveloper-managed server
for testing and debugging your applications from within the IDE. After installing
JDeveloper, everything you need to begin developing, testing and debugging web
applications is installed and configured for you; no additional configuration steps are
necessary for development purposes.

For additional information on using a standalone Oracle WebLogic Server instance
with JDeveloper, see the Deploying Applications chapter in the Oracle Fusion
Middleware User’s Guide for Oracle J[Developer.

12.1 Using the Integrated Oracle WebLogic Server

JDeveloper is bundled with an integrated application server called Integrated
WebLogic Server, and a default instance called IntegratediebLogicServer is
defined for it.

All applications are bound by default to IntegratedWebLogicServer. JDeveloper
manages the Integrated WebLogic Server lifecycle for testing your application. The
first time Integrated WebLogic Server is needed, JDeveloper creates the
DefaultDomain and prompts you to provide the administrative username and
password. The location of configuration files for the default domain is the
DefaultDomain directory located in the JDeveloper system directory.

12.2 Configuring Oracle WebLogic Server for ADF

The Oracle WebLogic Server domain that is created for you during installation,
DefaultDomain, is not intended for use outside of the IDE. To deploy ADF
applications to a standalone Oracle WebLogic Server, the server must be configured to
run ADF applications.

To prepare Oracle WebLogic Server for running ADF applications:

1. Install Oracle WebLogic Server 11g Release 1 (10.3.5). Use Oracle Installer to install
at least the Oracle WebLogic Server Core Application Server and Configuration
Wizard and Upgrade Framework components. You can install Oracle WebLogic
Server 11g Release 1 (10.3.5) using any Oracle distribution media.

For more information about installing Oracle WebLogic Server, see the following
documentation:

»  Oracle Fusion Middleware Getting Started With Installation for Oracle WebLogic
Server.

»  Oracle Fusion Middleware Installation Guide for Oracle WebLogic Server.
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2.

Add ADF runtime libraries to the Oracle WebLogic Server environment. This step
provides the necessary patches to Oracle WebLogic Server for ADF, and copies the
ADF runtime jar files and domain templates to the server environment. Add the
ADF Runtime in one of the two following ways:

s If you did not install the Application Development Framework Runtime
component during installation of Oracle WebLogic Server, you can do so by
running Oracle Installer as described in Section 3.2, "Launching the Installer".
Perform a custom installation, and install the ADF Runtime component into
the existing Oracle WebLogic Server home.

= Run the Oracle Fusion Middleware 11g Application Developer Installer which
is available through any of the Oracle Fusion Middleware distribution media.
The ADF runtime libraries for this release are provided as a patch to the
Application Development Runtime 11g Release 1 (11.1.1.5.0) installation.
Apply the ADF 11g Release 2 (11.1.2.4.0) patch to install the ADF runtime to
the existing Oracle WebLogic Server home. Oracle Application Developer
provides the ability to run standalone ADF applications in a server
environment managed by Oracle Enterprise Manager. For more information
about the Oracle Fusion Middleware 11¢g Application Developer Installer, see
the Oracle Fusion Middleware Installation Guide for Application Developer.

For more information about adding the ADF runtime libraries to a stand-alone
Oracle WebLogic Server, see the "Installing the ADF Runtime to the WebLogic
Installation" section in the "Deploying Fusion Web Applications" chapter in the
Oracle Fusion Middleware Fusion Developer's Guide for Oracle Application Development
Framework.

Configure a new or existing domain for ADF runtime. Before deploying an ADF
application to Oracle WebLogic Server, you must configure a domain for ADF
runtime. Use the WebLogic Configuration wizard to create a new domain
configured automatically to support Application Development Framework
Runtime or to extend an existing domain with the ADF runtime domain
templates.

For more information about configuring Oracle WebLogic Server domains and
preparing a domain for running ADF applications, see the following
documentation:

»  Oracle Fusion Middleware Creating WebLogic Domains Using the Configuration
Wizard.

s The "Creating and Extending WebLogic Domains" section in the "Deploying
Fusion Web Applications" chapter in the Oracle Fusion Middleware Fusion
Developer’s Guide for Oracle Application Development Framework.

13 JDeveloper Accessibility Information

The following sections provide information on how to use accessibility features in
JDeveloper, including how to perform a silent installation.

13.1 Installing Oracle JDeveloper Studio in Silent Mode

Silent-mode installation is a way of setting installation configurations only once to
ensure that no configuration options are displayed during the installation process.
During installation in silent mode, the installation program reads the settings for your
configuration from an XML file that you create before beginning the installation.
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To install in silent mode:

1. Create a silent.xml file that defines the configuration settings that will be used for
the installation. See Section Section 13.1.1, "Creating the silent.xml file" for more
information.

2. Start the silent installation by using the following command:

java -jar jdevstudiolll24install.jar -mode=silent
-log=install.log

The -log=install.log argument maintains a log of the installation in the
install.log file. Information contained in the log file helps you investigate
installation failures.

Note: To use a silent.xml file in a location other than the
directory in which Oracle Installer resides, also use the additional
argument -silent_xml=<your_location>\silent.xml.

13.1.1 Creating the silent.xml file

The silent.xml file contains several parameters that you can provide values for to
indicate your configuration preferences.

The parameters and their descriptions are listed in the Table 4, " silent.xml file
Parameters":

Table 4 silent.xml file Parameters

Resource Recommended

BEAHOME The full path for the Oracle Middleware Home directory of
your choice, for example, C: \Oracle\Middleware\.

In a silent install, specifying a value for this parameter in
silent.xml is mandatory.

COMPONENT_PATHS Specify the components and subcomponents to be installed.
If this parameter is not mentioned in silent.xml, all com-
ponents are installed by default.

Guidelines for component selection:

= If you specify a component to be installed, all its
subcomponents are automatically installed. For
example, if you specify the value JDeveloper and
ADF for this parameter, both its subcomponents, Oracle
JDeveloper Studio and Application Development
Framework Runtime are automatically installed.

s To install multiple components, separate the
components with a bar (|). To install subcomponents,
specify a component/subcomponent combination. For
example, to install Application Development
Framework Runtime, use the value JDeveloper and
ADF/Application Development Framework
Runtime.

m  If components you specify have dependencies on other
components that have not been specified, those
components also get installed.

INSTALL_SHORTCUT_IN_ALL_ Possible values:

USERS_FOLDER n yes/true: The shortcuts are created in All Users

folder (default).

n false/no: The shortcuts are created in the local user's
folder.

You must have Administrator privileges to install the short-
cuts in the All Users folder.
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Table 4 (Cont.) silent.xml file Parameters

Resource Recommended

LOCAL_JVMS Specify the location of your Java directory. This parameter
need not be specified if you launched Oracle Installer with
the desired JDK. The JDK specified in this parameter must
be JDK 6.0 Update 21 or later, otherwise it will be ignored.

Note: On Linux, UNIX, and Mac OS X systems, all symlink
references in the specified path are resolved to their hard
links.

13.1.2 Sample silent.xml file
For example, you may want to specify a silent installation with the following
configuration options:

= Middleware Home Directory: C: \Oracle\Middleware\.

s Components to Install: Oracle JDeveloper Studio and Application Development
Framework Runtime.

s Java Location: C:\jdk\jdkl.6.0_21\ or the most recent update available at the
time of install

s Shortcuts created in the local user's Start Menu folder.

To achieve this configuration, your silent .xml file should be coded like this:

<?xml version="1.0" encoding="UTF-8"?>
<bea-installer>
<input-fields>
<data-value name="BEAHOME" value="C:\Oracle\Middleware"/>
<data-value name="COMPONENT_PATHS" value="JDeveloper and ADF/JDeveloper
Studio\JDeveloper and ADF/Application Development Framework Runtime"/>
<data-value name="LOCAL_JVMS" value="C:\jdk\jdkl.6.0_21\"/>
<data-value name="INSTALL_SHORTCUT_IN_ALL_USERS_FOLDER" value="false"/>
</input-fields>
</bea-installer>

For more information about silent-mode installation for Oracle WebLogic Server,
please see the Oracle Fusion Middleware Installation Guide for Oracle WebLogic Server.

13.2 Using a Screen Reader and Java Access Bridge with JDeveloper

To make the best use of our accessibility features, Oracle Corporation recommends the
following minimum configuration:

s Windows XP, Windows Vista

= JavaJ2SE 1.6.0_21 or the most recent update available at the time of install
= Java Access Bridge 2.0.1

x  JAWS 12.0.522

= Microsoft Internet Explorer 7.0 or later

= Mozilla Firefox 3.5 or later

Please refer to the following procedures to set up a screen reader and Java Access
Bridge.

1. Install the screen reader, if it is not already installed.
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10.

11.

12.
13.

Refer to the documentation for your screen reader for more information about
installation.

Install JDeveloper.

For information about performing a silent installation, see Section 13.1, "Installing
Oracle JDeveloper Studio in Silent Mode".

Download Java Access Bridge for Windows version 2.0.1. The file you will
download is accessbridge-2_0_1.zip. Itis available from:
http://www.oracle.com/technetwork/java/javase/tech/index-jsp-
136191 .html.

Refer to the Java Access Bridge documentation available from this web site for
more information about installation and the Java Access Bridge.

Extract (unzip) the contents to a folder, for example, accessbridge_home.

Install Java Access Bridge by running Install.exe from the <accessbridge_
home>\installer folder.

The installer first checks the JDK version for compatibility, then the Available Java
virtual machines dialog displays.

Click Search Disks. Then select to search only the drive that contains the
JDeveloper build and the JDK version in the program files directory (if it exists).

The search process can take a long time on a large disk with many instances of
JDK or JDeveloper, or when searching multiple disks. However, unless you
complete an exhaustive search of your disk, Access Bridge will not be optimally
configured, and will not be correctly installed to all of the Java VMs on your
system. After selecting the disk to search, click Search.

Confirm that you want to install the Java Access Bridge into each of the Java
virtual machines displayed in the dialog, by clicking Install in AlL

Click OK when you see the Installation Completed message.

Confirm that the following files have been installed in the Winnt\System32
directory (or the equivalent Windows XP or Vista directory), or copy them from
<accessbridge_home>\installerfiles asthey must be in the system path
in order to work with JDeveloper:

JavaAccessBridge.dll
JAWTAccessBridge.dll
WindowsAccessBridge.dll

Note that the system directory is required in the PATH system variable.

Confirm that the following files have been installed in the Mw_
HOME\jdk\jre\lib\ext directory, or copy them from <accessbridge_
home>\installerfiles:

access-bridge.jar

jaccess-1_4.jar

Confirm that the file accessibility.properties has been installed in the <jdev_
home>\Jjdk\jre\lib directory, or copy it from \installerfiles.

Start your screen reader.

Start JDeveloper by running the file jdev . exe located in the folder Mw_
HOME\ jdeveloper\jdev\bin.
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The steps above assume you are running Windows and using a Windows-based
screen reader. A console window that contains error information (if any) will open
first and then the main JDeveloper window will appear, once JDeveloper has started.
Any messages that appear will not affect the functionality of JDeveloper.

13.3 Finding Accessibility Information

For the latest configuration information or for information on addressing accessibility
and assistive technology issues, see the Oracle Accessibility FAQ at
http://www.oracle.com/us/corporate/accessibility/fags/index.html
. Also, see the Oracle JDeveloper Accessibility Information chapter in the Oracle Fusion
Middleware User’s Guide for Oracle [Developer.

14 Uninstalling JDeveloper
To uninstall Oracle JDeveloper Studio, run the uninstaller which is located at:
s  MW_HOME\utils\uninstall\uninstall.exe on Windows systems.

m MW _HOME/utils/uninstall/uninstall on Linux, UNIX and Mac OS X
systems.

To run the uninstaller in silent mode, run the file with the -mode=silent attribute,
for example:

s MW _HOME\utils\uninstall\uninstall.exe -mode=silent on Windows
systems.

m MW _HOME/utils/uninstall/uninstall -mode=silent on Linux, UNIX,
and Mac OS X systems.

Note: The uninstaller removes only those files that were created at
the time of installation. Any files that were created or modified after
the installation are left as is. A message about the files and folders that
have not been removed is displayed at the end of the process. You can
delete these files if you wish to.

The uninstaller also does not remove the system directory, which
includes the Oracle WebLogic Server domain provided in JDeveloper,
DefaultDomain.

To uninstall JDeveloper Java Edition:

= Delete the installation directory. No other action is necessary.

15 Oracle on the Web

Oracle provides a number of resources on the Web. Some sites you may find helpful
are listed in Table 5, " Oracle on the Web":

Table 5 Oracle on the Web
Description URL

JDeveloper Home Pages http://www.oracle.com/technetwork/devel-
oper-tools/jdev/overview/index.html
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Table 5 (Cont.) Oracle on the Web

Description URL
JDeveloper Discussion Forum http://forums.ora-
cle.com/forums/forum. jspa?forumID=83
Corporate Site http://www.oracle.com/
Oracle Technology Network http://www.oracle.com/technetwork/index.html
Oracle Accessibility Site http://www.oracle.com/us/corporate/accessi-

bility/index.html

16 Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Oracle® Fusion Middleware Installation Guide for Oracle JDeveloper 11g Release 2 (11.1.2.4.0)
E17074-06

Copyright © 1997, 2013, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected
by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate,
broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering,
disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them
to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the
following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and
agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions
and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway,
Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use
in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in

dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe
use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks
or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered
trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle
Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products,
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of
third-party content, products, or services.

23



24



	1 JDeveloper System Requirements
	1.1 Recommended CPU, Memory, Display, and Hard Drive Configurations

	2 JDeveloper Certification Information
	3 Installing the Oracle JDeveloper Studio Edition
	3.1 Before You Begin
	3.2 Launching the Installer
	3.3 Installer Screens
	3.4 Verifying Your Installation

	4 Installing the JDeveloper Java Edition
	5 Using JDeveloper on Windows
	5.1 Starting JDeveloper
	5.2 Specifying the JDK location
	5.3 Changing the JDK location
	5.4 User Directories

	6 Using JDeveloper on Linux and UNIX Systems
	6.1 Changing System Cursors
	6.2 Setting the System Resource Limit
	6.3 Starting JDeveloper
	6.4 Specifying the JDK location
	6.5 Changing the JDK location

	7 Using JDeveloper on Mac OS X Platforms
	7.1 Starting JDeveloper
	7.2 Specifying the JDK location
	7.3 Changing the JDK location

	8 Migrating from a Previous Version
	8.1 Migrating User Settings
	8.2 Migrating Projects
	8.2.1 Migrating JSF and JSTL Projects


	9 Enabling JDeveloper Extensions
	10 Setting the User Home Directory
	10.1 Setting the Home Environment Variable on Windows
	10.2 Setting the Home Environment Variable on Linux and UNIX
	10.3 Setting the Home Environment Variable on Mac OS X

	11 Using JDeveloper in a Multiuser Environment
	11.1 Installing JDeveloper on a Citrix MetaFrame Server or a Microsoft Terminal Server
	11.2 Configuring User Home Directories in a Multiuser Environment
	11.3 Configuring Terminal Server Clients for Running JDeveloper

	12 Using Oracle WebLogic Server with JDeveloper
	12.1 Using the Integrated Oracle WebLogic Server
	12.2 Configuring Oracle WebLogic Server for ADF

	13 JDeveloper Accessibility Information
	13.1 Installing Oracle JDeveloper Studio in Silent Mode
	13.1.1 Creating the silent.xml file
	13.1.2 Sample silent.xml file

	13.2 Using a Screen Reader and Java Access Bridge with JDeveloper
	13.3 Finding Accessibility Information

	14 Uninstalling JDeveloper
	15 Oracle on the Web
	16 Documentation Accessibility

